NH_SAL: New Hire Salaried, Fiscal/Academic
Revised March 27, 2007

Use the NH_SAL EPAF for new employees who are being assigned either a salary fiscal year
position or an academic year position. NH_SAL is for benefit eligible non-exempt, exempt,
and faculty positions.

Use PPAIDEN to “create” a new person-but only after completing a thorough search! See
pictorial instructions on PPAIDEN on HR website. If the person already has an A number, skip
to the next paragraph.

To see if a person has an employee record in Banner:
1. Access PEAEMPL (Departments will only have query access to this screen. You

cannot change any data.)

Enter in the persons Banner A-# example (A0001234)

CTRL PG Down (Next Block)

4. |If they have no job the message at the bottom of the screen will read “query
caused no records to be retrieved”. Continue using NH_SAL EPAF.

5. Ifthey are active and have information already in PEAEMPL then use the JB_SAL
EPAF.

wn

NOAEPAF: Access this form by typing NOAEPAF in the “Go To...” Box
ID: Enter the employee’s A-Number
Query Date: The Query Date should be the date of the employment action and should
match or be prior to the Job Effective Date and Job Begin Date in the next part of the EPAF.
You may find it is easier if the Query Date, Job Effective Date and Job Begin Dates are the
same.
Banner will automatically prorate the monthly payment if an employee starts on a
day other than the first of the month. If an employee starts after the Banner
deadlines but before the first of the new month, then the first day of the new
month should be the Effective Date with a comment that retro-active pay is
needed.
Approval Category: NH_SAL
Approval Type: The Approval type will populate automatically.
Transaction Number: This number will populate as you move through the form.
Next Block: Move to the next block of information by pressing control page down, or
selecting “Next” in the “Block” pull-down menu, or clicking on the “Next Block” icon
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[JPending Change Proxy For: | F|

ID: |A01103484 F|Memphis Tenneses Generate ID: @

Transaction: | [7| Query Date: W[_ Last Paid Date: ,7
’NH_TF Mew Hire Salaried Fiscal Year Position: | F|
[ve_PEs [+ PEAEMPL Suffix: [ ™
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%= alternate Logon Verification Form GUAUIPYW 7.0 (ZDEVL) X Al |

Before you can continue, you
will be asked to provide your

Alternate User ID: |LIZ_KEF.¢'.LIUER password. Although it asks for
Alternate Password:  [*wxekainr] < an alternate password, your
normal Banner password will
L Merify work.
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[JPending Change Proxy For: | [7|
ID: |A01103484 F|Memphis Tenneses Generate ID: @
Transaction: |4?551 F|Waiting Query Date: WF Last Paid Date: ,7
’NH_TF Mew Hire Salaried Fiscal Year Position: | [7|
[ve_PEs [+ PEAEMPL Suffix: [ ™
Default Earmings o] =1 ] o = e e W e Routing Other Information and Comments
Applied
Status Field Name Current ¥alue MNew Value
E‘
|P— |Emp|0yee Class Code | @ [~ |
[P [current Hire Date | [01-maR-z007
[ [Home coas | u
|P— |19 Form Indicator | |R
[P [13 Date | [01-maR-zoo7
|P— |19 Expiration Date | |
|P— |H0rne Organization | |DPPERS
|
|
|

[
[
[

Press LIST for valid codes.,

Employee Class Code: Click on the New Value down arrow button and choose the
Employee Class Code.

Current Hire Date: The date of hire.

Home COAS: Defaults to U and cannot be changed.

19 Form Indicator: Select (R)eceived=US Citizen; (T)emporary=Non-USU Citizen; (E)xempt=a
person who works outside of the US or as a volunteer.

|19 Date: The date the 19 was signed.

19 Expiration Date: Date of expiration for an employee on a temporary visa. Use only for
employees on a temporary visa. You must put in date if 9 Form Indicator is a (T)emporary.
Home Organization: Department’s unique “DP” or “UN” code i.e. DPMATH for Math Dept.
Save: Press F10, click on the save icon or click on Save in the File pull-down menu.

Click on the Options menu and select “Next “Action”

OR

Rollback by clicking on the round arrow or pressing Shift F7. Double click in the arrow box
next to the Approval Type Field and select JB_S.

Position Number: Type the position number in the field. If you don’t know the number, click
on the arrow next to the field. Click on List of All Positions. (See next page for instructions)
Suffix: 00 for new assignments




01, 02, 03...for additional assignments in the same department and position
number.

Check with NBAJOBS and NBIJLST to ensure you are using the correct suffix.
Next Block: Move to the next block of information by pressing control page down, or
selecting “Next” in the “Block” pull-down menu, or clicking on the “Next Block” icon

< Oracle Develoser Forms Runtime - Web® Zuen > NOAEPAF

File Edit Optiorg
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[JPending Change Proxy For: || E|
ID: |A011E|3484 E”Mernphis Tenneses Generate ID: @
Transaction: |4?551 E|Waiting Query Date: m Last Paid Date: ,7
,NH_TEINBW Hire Salaried Fiscal Year Position: |99?549 EHS ff Assistant 111
lm_si[zﬁalary Job Process Suffix: ’WEI Click here to find
position number
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Find the Position Number:

The search form will show all positions at USU. You can narrow the search so you will see only
positions in your department. Put your cursor in the top position number field and press F7 to
clear the form.

< Oracle Developer Forms Runtime - Web: Open > NOAEPAF - NBQPOSN

Enter the employee class (SE, SN, FA, etc), the COA (U) and the DPCODE (all letters in
UPPERCASE!) In this example, all of the salary exempt positions in DPPERS (Human Resources)
are shown. Press F8.
Note: to see all jobs in a department, leave the employee class field blank.
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File Edit Options Block Item Record Query Tools Help
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Employee Budget Position
Title Class COA Orgn Description Begin Date End Date Class Status Type

| |Professor Fa~ o | | [po-mar-2007 | 20001 F E =
396513 [Project Coordinator E |U [DPsPEL[Special Education & Rehabilitatic  [01-MAR-zOD7 | 30051 |? |s—
096520 [staff Assistant 111 [su [0 [DPaDwi[animal, Dairy & usterinary scie  [01-JUN-zoo? | [s0009 A s
396521 |security Specialist [se | [u [oPnFT [vice Pres - Information Technal  [o1-Mar-z007 | 20074 [+ [s]
996522 |nutrition Assistant 11 [sw [u [orersF[Field staff - EFnEP [o1-mar-zoo7 | 70010 [
096523 [Nutrition Assistant 11 [su [o  [DPEFsF|Field staff - EFNER [o1-mar-zoo7 | [roo10 A s
[396524 [Nutrition Assistant 111 [sn | [o [orersF[Field staff - EFnEP [o1-mar-zoor | 70010 [ [s]

File Edit Options Block Iterm Record Query Tools Help
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Employee Budget Position
Title Class COA  Orgn Dedcription Begin Date End Date Class Status Type
36| |Staf‘f Assistant 1T ’K |E |DPPERS|Huqurces |01-JUL-2DDS | |50009 F |S— =

397537 [staff Assistant 111 SN_\HH# Gman Resources |01-10L-2005 | 50003 F |s_
[397545 [Coord Human Resources [sn | [u [DPPERS[HUman Resources [01-30L-2005 | [sn005 [+]  [5
[397549 [staff Assistant 111 [sw [0 [oPPERS[Human Resources [o1-u-z005 | 50003 [+ [z
|99?55El |Staff Assistant II1 ’K |E |DPPERS|Hurnan Resources |01-JUL-2DDS | |50009 F |S—
[397551 |Coord wage/Salary IK |U |pPPERZ[HUMaN Resaurces [o1-30L-2005 [ [s0004 F |s—
[397552 [Office Assistant 111 [su [0 [peeERs[Human Resourses |01-10L-2005 | |sn007 [+ [s
397553 [staff Assistant 111 [su [ [oeeERsHuman Resources [o1-3u-z005 | 50003 [+ [s
T T 1 [T T T T T mE




Arrow down to highlight the correct position number, then double click on the correct
position number to return to the EPAF. You can also see the position number by looking at
the previous employee in NBAJOBS.

Next Block: Move to the next block of information by pressing control page down, or
selecting “Next” in the “Block” pull-down menu, or clicking on the “Next Block” icon
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O Pending Change Proxy For: | [7|
ID: |A01103484 F|Memphis Tennesee Generate ID: @
Transaction: |4?551 F|Waiting Query Date: WF Last Paid Date: ,7
INH_T[T Mew Hire Salaried Fiscal Year Position: |99?549 F|Staf-f Assistant 111
IJE\_SifT Salary Job Process Suffix: EF
Default Earmings Jab Cabor DisthbutiEn Routing Other Information and Cormments
Applied
Status Field Name Current Yalue MNew Yalue
v
|— |Jobs Effective Date | =
|— |Personne| Date |
[ [10b Begin Date | |01-maRr 2007
|— |Contract Type | |P
[ [ritle | [staff Assistant 111
[ [re | B
|— |Appointrnent Percent | |1DD
|_ |Base Salary | |23000
[ [10b Location | [marr -
|— |J0b Change Reason | |E1 4’ -
Use scroll bar to see all fields. .
|— |Job Change Reason | |E1
[ [rimesheet oran | [preERS =]

Job Effective Date: The first day the employee begins or the first day of the next pay period if
you missed the payroll deadline. This date must be the same as or after the query date.
Personnel Date: This is the date something should have happened if different than the
Effective Date. It can be a date in the future or past.

Job Begin Date: This must be the same as the Job Effective Date.

Contract Type: P (Primary) is defaulted. Always use P for new hires.

Title: Enter the title of the position.

FTE: 1 for full time and .75 for 75% time. The FTE does not affect salary but it does affect
benefit rates.

Appointment Percent: Enter the appointment percent for the position. This does affect salary.
Enter as 100, 75, 50, etc.

Base Salary: The monthly amount an employee will be paid times 12.

Example: Jane is paid $3000/month. 12X3000=$36 K.

Job Location: Main (Main campus is the default but it can be changed to CONT ED by
clicking on the arrow under “New value) at the top of the column.

Job Change Reason: Click on the arrow beneath “New Value” to see a list of codes. Select
the appropriate code and click on it to put it in the field.




Timesheet Orgn: Enter your home department DP-code. (Example: DPMATH)
Save by pressing F10 or clicking on the save icon or the File Pull-down Menu.

Click on the Options menu and select “Next “Action”

OR

Rollback by clicking on the round arrow or pressing Shift F7. Double click in the arrow box
next to the Approval Type Field and select JB_LBR.

Next Block: Move to the next block of information by pressing control page down, or
selecting “Next” in the “Block” pull-down menu, or clicking on the “Next Block” icon
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O Pending Change Proxy For: | F|
ID: |A01103484 F|Memphis Tennesee Generate ID: @
Transaction: |4?551 F|Waiting Query Date: 01-MAR-2007 [_ Last Paid Date:
NH_SAL [ Mew Hire Salaried Fiscal Year Position: |99?549 F|Staf-f Assistant 111
JB_LER ¥ Job Labor Distribution Suffix: 0o |[7]
Transaction Default Earritgs Job Labor Distribution Routing Cther Information and Comments

Current Job Labor Distribution

Effective Date: 01-MAR-2007

COA Index Fund Organization  Account Program Actvivity Location Project Cost Percent

[ | | | | | | |

[ | | | | | | |

[ | | | | | | |

L | | | | | | |

New Job Labor Distribution Effective Date must match date in E
Ensure accountlng information is accurate.

COA Index Fund Organization Account Program Actvivity Location Project

M O ] ] ) ] [ N )

b [aoeser 101164 [E0za32 615300 s0s0 | | |

[ | | | | | | |

[ | | | | | | |

o | | | | | Percent must equall_O

Total Percent: 100.00

A R R T R R e

This is the account(s) that will pay for the position. A position may be paid from more than
one index. Ensure that the accounting information is correct. Please ensure the Percent
eqguals 100.

Effective Date: Change this date to match the effective date in the previous blocks.
Save by clicking F10 or clicking on the save icon or the File Pull-down Menu.

DO NOT ROLLBACK.




Click on the Options menu and select Routing Information or click on the Routing tab.
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Cancel PAF

I Pent >
Delete PAF [_l
ID: " —— ide Generate ID: &
F [ aiting Query Date: 06-0CT-2006 [
&r [nformation and Comments  fsignment Salaried FY Position: |99?544 F|Human Resources Specialist
Approy Errors or Warnings Detail Farm bor Distribution Suffix: on [7

Electronic Approval Summary Form

Transaction Default EarminEs Job Labar Distribution Routing Other Infarmation and Comments

v

Clicking on the arrow under “User ID”” will provide names of possible approvers. Select the
correct approvers for your area or you can type their User ID.
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fmElectronic Personnel Action NOAEPAF 7.3.0.1 (ZPPRD) i T T
O Pending Change Proxy For: | F|
ID: |A01103484 F|Memphis Tennesee Generate ID: @
Transaction: |4?551 F|Waiting Query Date: W[T Last Paid Date: ’7
’NH_TF Mew Hire Salaried Fiscal Year Position: |99?549 F|Staf-f Assistant 111
1B_LBR ¥ Job Labor Distribution Suffix: [oo [+

Transaction Default Earmings Job Labor Distribution Other Information and Comments

Originator ID:  |LEANNA_LAMMERT |Leanna Lammert
Required Queue
Level Name Action Status Action Date
(7]

20 [BRAMDE_FAUPELL [BrandE Faupell |#pproval ~| In Queue | =]
[pHome |25 |GLENN_FORD |w Glenn Ford [approval ~| [in Queue |

exec s [PRESIDENT_OFFICE [office President approval | [In Queue |

|Hr a0 |HR_oFFice |office HR [approval =] [in queue |

[appLY [s5 |Hr_oFFIcE |office HR [apaly 7| [in Queue |

| | | | | |

[ [ [ [ [ 1T [

Press F10 or click on the save icon to save the routing information.

Add comments. Click on the Other Information and Comments tab. Include information
about why the person is being hired, who is being replaced, and any other information that
will be helpful to the approvers. Your name and the date will be recorded by the system.
Please include your phone number in case there are questions. EPAFs with no comments
may be returned to the originator.




[JPending Change Proxy For:

(=]

ID: |A01103484 F|Memphis Tenneses Generate ID: @
Transaction: |4?551 [7|Waiting Query Date: 01-MAR-2007 [_ Last Paid Date:
NH_SAL [~ Mew Hire Salaried Fiscal vear Position: |99?549 F|Staff Assistant 111

IB_LER [+ 10b Labaor Distribution Suffix: EF

( Transaction , Default Earmings Job Labor Distribution Routing Other Information and Comments

Created Date: |27-MAR-2007

Originator ID: |LEANNA_LAMMERT

Submitted Date: Application Date:

Submitter ID: | Applied to Database By: |

Comment: Mew Hire effective March 1, 2007, Competitive hire req number 050555, Full- = Date and Time: |2?-MAR-2DD? 01:51:04 PM =
time at $23,000, 7-1810

Made By: |LEANNA_LAMMERT

1]

Press F10 or click on the save icon to save your comments. Comments cannot be changed

after saving.

To submit the EPAF, click on the Transaction tab. Click on Options and select Submit

Transaction.



